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LAMPIRAN 1

SKEMA ALAT KESELURUHAN
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Keterangan :
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Skala : Distj : Masduki Z A4 NO 1
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LAMPIRAN 2

DAFTAR KOMPONEN, ALAT, BAHAN

Komponen: Alat:

1. Arduino Uno 1. Solder

2. Relay 2 Channel 2. Tenol

3. Sensor Proximity 3. Gergaji Besi

4. Buzzer 220VAC 4. Bor Tangan

5. Solar Cell 5.Gerinda
6. Solar Charger Control 6. Tang ‘Kombmas1
7. Baterai (Accu) 7. Gunting

8. Inverter 8. Cutter

9. Obeng
10. Multimeter

Bahan:

1. Akrilik

2. Plat Alumunium

3. Besi

4. Kabel

5. Mur & Baut

6. Insulock

7. Kabel NYAF

8. Isolasi Hitam

Keterangan

Daftar Komponen, Alat, Bahan

A4 | NO.2

UNIVERSITAS NEGERI Skala : Distj : Masduki Z

YOGYAKARTA Digmb : Ichwan CR Diprs : Masduki Z 15507134019




LAMPIRAN 3

GAMBAR ALAT

Frame Alat

Alat Keseluruhan

Keterangan :
Gambar Alat
- — : A4 | NO.3
UNIVERSITAS NEGERI Skala : Distj : Masduki Z
YOGYAKARTA Digmb : Ichwan CR | Diprs : Masduki Z 15507134019




LAMPIRAN 4

SKEMA RANGKAIAN KESELURUHAN
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< Keterangan :
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: — : A4 | NO.4
UNIVERSITAS NEGERI Skala : Distj : Masduki Z
YOGYAKARTA Digmb : Ichwan CR | Diprs : Masduki Z 15507134019




LAMPIRAN 5

KEAMANAN (Safety)

Keamanan:

A. Resiko Bahaya
1. Tersengat listrik tegangan tinggi
(Plat Penyetrum).
2. Menyebabkan terkejut, bahkan bisa
berakibat fatal.

B. Alat Pelindung Diri (APD)
1. Gunakan sarung tangan saat dan
matikan power listrik melakukan
perbaikan atau perawatan.
2. Gunakan ear plug (alat pelindung telinga)
saat buzzer bunyi.

C. Perlakuan Kerja Aman
1. Tidak boleh menyentuh plat tegangan
tinggi saat masih aktif.
2. Jauhkan alat dari area basah

Keterangan :

Keamanan (Sefety)

A4 | NO.5

UNIVERSITAS NEGERI Skala : Distj : Masduki Z

YOGYAKARTA Digmb : Ichwan CR Diprs : Masduki Z 15507134019




LAMPIRAN 6

LISTING PROGRAM

/*
TEST CODE FOR PROXIMITY SENSOR

Metal Detection with 3 wire sensor
*/

void setup() {

pinMode (2, OUTPUT); // mendefinisikan pin 2 sebagai output (Relay IN1)
pinMode (3, OUTPUT); // mendefinisikan pin 3 sebagai output (Relay IN2)
Serial.begin (9600);

H
void loop() {
int NilaiSensor = analogRead(A0);
float Tegangan = NilaiSensor * (5.0 / 1023.0);
if (NilaiSensor >3) {
digitalWrite (2, LOW);
digitalWrite (3, LOW);

j

else {
digitalWrite (2, HIGH);
digitalWrite (3, HIGH);

}
Serial.println (Tegangan);

}

Keterangan :

Listing Program

) —— A4 | NO.6
UNIVERSITAS NEGERI | Sk Distj : Masduki Z
YOGYAKARTA Digmb : Ichwan CR Diprs : Masduki Z 15507134019




LAMPIRAN 7
Uji Lapangan Automatic Mouse Trap
Yaitu pengujian alat untuk menangkap tikus
Lokasi pengujian : Sawah milik Pak Kasha
Alamat di Dusun Karanggayam RT 03 (Ketua RT)
Bantul, Bantul Kota, Jawa Tengah

Waktu pengujian : 15 Desember s/d 19 Desember 2018

Hasil : Hasil pengujian disajikan pada tabel berikut:
Sensor Tegangan Jumlah
Hari | o ovimity | RELAY | 11991220 | gj77eR | Tikus Yang | KONdisi
Ke - . vac Tikus
Inductive Tertangkap
(penyetrum)
1 Cover HIGH AKTIF ON 1 Tikus Mati
Terbuka
2 Cover HIGH AKTIF ON 2 Tikus Mati
Terbuka
3 Cover HIGH AKTIF ON 1 Tikus Mati
Terbuka
Cover
4 Tertutup LOW i OFF ) i
Cover
5 Tertutup LOW i OFF ) i




LAMPIRAN 8
DATASHEET SOLAR CELL

SC ol'l gIN  Solar Panel - Polycrystalline (SPM050-P)
Inspired by the Sun! with 50 Wp

EFFICIENCY

+ Low vollage-lamperature coefficient ensures
high-temperature operation

+ Exceptional low-light performance combined
with high sensitivity to light enables excellent
energy delivery

» Upto 17.37% solar cell efficlency

+« Upto 14.62% module efficlency

MATERIALS

+ Highest guality, high-transmission tempearned
glass provides enhanced stiffness and
impact resistance

» Advanced EVA encapsulation system with
Iriple-layer back sheel meels the most
stringent safety requiremeants for high-voltage
operation

+ A sturdy, anodized aluminum frame allows
modules 1o be easily roof-mountad with a
variely of standard mounting systems

» Ulrra reliable bypass diodes prevent damage
through everhealing due to shaded or
defective cells

»  Innovative, environmentally friendly
packaging method using pile-edges ensures
modules arive in perfect condition

BENEFITS
» Manufactured In an IS0 9001 :2000 certified
plant
+ High efficiency, high safety, high reliability
+«  Oulput power tolerance of +/-5%
+  25-year limiled warranly on power output, 5-

year limited warranty on materials and h-"4
workmanship Solar Power 1 iMart
« Generate more energy per square meter Harvest the Sunpowerd

+ Eqguipped weatherproof junction box, flawless
operation in weal weather and marine
applications

+ Resilient to harsh weather conditions

+ Optimal panel performance

+ Long term product performance

www solarpower-marl.com www scorlgin.com



Specifications

Cells Polycrystalline silican solar cells 156x156mm I
Mumber of cells B6(4=3)

Dimensions (mm) 760 x668 x 35 |
Weight (kg) 85

Electrical Characteristics

Values at Standand Test Conditions STC (Adr Mass AM1.E, madiance 1000W/m?, Cell Temparature 25°C)

Mace Power Pm (W) 50

Mazx Power Current Im (&) 265

Short-Circuit Current Isc (A) 2.54

Module Efficiency (%) 100

Power Tolerance (%) +3

Components & Mechanical Data

Front Glass High Transparency Tempered Glass, 3.2mm

" Output Cablas dm0.9m ) ) )
Connaciors MC4{UV resistance and self-locking/IPET)
Frame Anodized aluminum alloy type G063-T5 ||
Encapsulation Material EVA (050 + 0.03mm thickness)
Back Fol White TPT (0.32 £ 0.03mm thickness) |
Fixing adhesive Silicone Ssalant(White)

Temperature Range("C) -40°C to +90°C

Temperature Coefficients

Coefficent of Pm -0.45:0.05

Temperature Coeffident of Voc (%/™C) -0.35:0.02

wiww solarpower-mart.com WA OrIgIn. Com
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LAMPIRAN 9
DATASHEET BUZZER 220V AC

BUZZER 220V AC
Model:HRB-N80

- The most popular electronic buzzer , suit for the industry field.

- High quality, and last working for a long time, no Electromagnetic Interference.
- Long life, and nice tone.

- Function: continual alarm and intermittent alarm optional.

HEB-N80 | ACZ20V 8.4x8 2x4 9cm 97g

40 6

52
—
—I

Made in China

12



LAMPIRAN 10
DATASHEET ARDUINO

Arduino UNO

MADE

INITALY o= ~©ine MmN
L 1
A% " 888 DIGITAL (PWM~)

 rxems ARDUINO
(416006 ) “a
fil]eoem s caf@I 0 suvoae
. & <8

Product Overview

The Arduino Uno is a microcontroller board based on the ATmega328 (datasheet). It has 14 digital
input/output pins (of which 6 can be used as PWM outputs), 6 analog inputs, a 16 MHz crystal oscillator, a
USB connection, a power jack, an ICSP header, and a reset button. It contains everything needed to
support the microcontroller; simply connect it to a computer with a USB cable or power it with a AC-to-DC
adapter or battery to get started. The Uno differs from all preceding boards in that it does not use the FTDI
USB-to-serial driver chip. Instead, it features the Atmega8U2 programmed as a USB-to-serial converter.

"Uno" means one in ltalian and is named to mark the upcoming release of Arduino 1.0. The Uno and version
1.0 will be the reference versions of Arduno, moving forward. The Uno is the latest in a series of USB
Arduino boards, and the reference model for the Arduino platform; for a comparison with previous versions,
see the index of Arduino boards.

.Sr%%r::?til%gltions Page 2
gggvr!rﬁgir%séenﬁrggnipésicTutorials Page 6
-(r%rrirc]j?ti%ns Page 7
Sl el Page 7

E} RadiosparRes RADIONICS _ A
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Technical Specification

EAGLE files: arduino-duemilanove-uno-design.zip Schematic: arduino-uno-schematic. pdf

Summar
Microcontroller ATmega328
Operating Voltage 5V
Input Voltage (recommended) 7-12V
Input Voltage (limits) 6-20V
Digital I/0 Pins 14 (of which 6 provide PWM output)
Analog Input Pins 6
DC Current per I/O Pin 40 mA
DC Current for 3.3V Pin 50 mA
Flash Memory 32 KB of which 0.5 KB used by
bootloader
SRAM 2KB
EEPROM 1KB
Clock Speed 16 MHz

the board

MADE
IN XTALY

"= ARDUINO
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Power
The Arduino Uno can be powered via the USB connection or with an external power supply. The power
source is selected automatically.

External (non-USB) power can come either from an AC-to-DC adapter (wall-wart) or battery. The adapter
can be connected by plugging a 2.1mm center-positive plug into the board's power jack. Leads from a
battery can be inserted in the Gnd and Vin pin headers of the POWER. connector.

The board can operate on an external supply of 6 to 20 volts. If supplied with less than 7V, however, the 5V
pin may supply less than five volts and the board may be unstable. If using more than 12V, the voltage
regulator may overheat and damage the board. The recommended range is 7 to 12 volts.

The power pins are as follows:

* VIN. The input voltage to the Arduino board when it's using an external power source (as opposed to
5 volts from the USB connection or other regulated power source). You can supply voltage through
this pin, or, if supplying voltage via the power jack, access it through this pin.

* 5V. The regulated power supply used to power the microcontroller and other components on the
board. This can come either from VIN via an on-board regulator, or be supplied by USB or another
regulated 5V supply.

= 3V3. A 3.3 volt supply generated by the on-board regulator. Maximumn current draw is 50 mA.

+ GND. Ground pins.

Memor

The Atmega328 has 32 KB of flash memory for storing code (of which 0.5 KB is used for the bootloader); It
has also 2 KB of SRAM and 1 KB of EEPROM (which can be read and written with the EEPROM library).

Input and Output

Each of the 14 digital pins on the Uno can be used as an input or output, using pinMode(), digital\Write(), and
digitalRead() functions. They operate at 5 volts. Each pin can provide or receive a maximum of 40 mA and
has an intemal pull-up resistor (disconnected by default) of 20-50 kOhms. In addition, some pins have
specialized functions:

+ Serial: 0 (RX) and 1 (TX). Used to receive (RX) and transmit (TX) TTL serial data. TThese pins are
connected to the corresponding pins of the ATmega8U2 USB-to-TTL Serial chip .

= External Interrupts: 2 and 3. These pins can be configured to trigger an interrupt on a low value, a
rising or falling edge, or a change in value. See the attachinterrupt{) function for details.

« PWM:3,5,6,9, 10, and 11. Provide 8-bit PWM output with the analogWrite() function.

« SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). These pins support SPI communication, which,
although provided by the underlying hardware, is not currently included in the Arduino language.

* LED: 13. There is a built-in LED connected to digital pin 13. When the pin is HIGH value, the LED is
on, when the pin is LOW, it's off.

@ E] Radlospares RADIONICS mAm



The Uno has 6 analog inputs, each of which provide 10 bits of resolution (i.e. 1024 different values). By
default they measure from ground to 5 volts, though is it possible to change the upper end of their range
using the AREF pin and the analogReference() function. Additionally, some pins have specialized
functionality:

= P’C: 4 (SDA) and 5 (SCL). Support I°C (TWI) communication using the Wire library.
There are a couple of other pins on the board:

s AREF. Reference voltage for the analog inputs. Used with analogReference().
» Reset. Bring this line LOW to reset the microcontroller. Typically used to add a reset button to
shields which block the one on the board.

See also the mapping between Arduino pins and Atmega328 ports.

Communication

The Arduino Uno has a number of facilities for communicating with a computer, another Arduino, or other
microcontrollers. The ATmega328 provides UART TTL (5V) serial communication, which is available on
digital pins 0 (RX) and 1 (TX). An ATmega8U2 on the board channels this serial communication over USB
and appears as a virtual com port to software on the computer. The '8U2 firmware uses the standard USB
COM drivers, and no external driver is needed. However, on Windows, an “.inf file is required..

The Arduino software includes a serial monitor which allows simple textual data to be sent to and from the
Arduino board. The RX and TX LEDs on the board will flash when data is being transmitted via the USB-to-
serial chip and USB connection to the computer (but not for serial communication on pins 0 and 1).

A SoftwareSerial library allows for serial communication on any of the Uno's digital pins.

The ATmega328 also support 12C (TWI) and SP| communication. The Arduino software includes a Wire
library to simplify use of the 12C bus; see the documentation for details. To use the SPI communication,
please see the ATmega328 datasheet.

Programming

The Arduino Uno can be programmed with the Arduino software (download). Select "Arduino Uno w/
ATmega328" from the Tools > Board menu (according to the microcontroller on your board). For details,
see the reference and tutorials.

The ATmega328 on the Arduino Uno comes preburned with a bootloader that allows you to upload new code
to it without the use of an external hardware programmer. It communicates using the original STK500
protocol (reference, C header files).

You can also bypass the bootloader and program the microcontroller through the ICSP (In-Circuit Serial
Programming) header; see these instructions for details.

The ATmega8U2 firmware source code is available . The ATmega8U2 is loaded with a DFU bootloader,
which can be activated by connecting the solder jumper on the back of the board (near the map of Italy) and
then resetting the BU2. You can then use Atmel's FLIP software (Windows) or the DFU programmer (Mac
0S X and Linux) to load a new firmware. Or you can use the ISP header with an external programmer
(overwriting the DFU bootloader).

@ E] radiospares rapiomics /Al
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Automatic (Software) Reset

Rather than requiring a physical press of the reset button before an upload, the Arduino Uno is designed in a
way that allows it to be reset by software running on a connected computer. One of the hardware flow control
lines (DTR) of the ATmega8U2 is connected to the reset line of the ATmega328 via a 100 nanofarad
capacitor. When this line is asserted (taken low), the reset line drops long enough to reset the chip. The
Arduino software uses this capability to allow you to upload code by simply pressing the upload button in the
Arduino environment. This means that the bootloader can have a shorter timeout, as the lowering of DTR
can be well-coordinated with the start of the upload.

This setup has other implications. When the Uno is connected to either a computer running Mac OS X or
Linux, it resets each time a connection is made to it from software (via USB). For the following half-second or
so, the bootloader is running on the Uno. While it is programmed to ignore malformed data (i.e. anything
besides an upload of new code), it will intercept the first few bytes of data sent to the board after a
connection is opened. If a sketch running on the board receives one-time configuration or other data when it
first starts, make sure that the software with which it communicates waits a second after opening the
connection and before sending this data.

The Uno contains a trace that can be cut to disable the auto-reset. The pads on either side of the trace can
be soldered together to re-enable it. It's labeled "RESET-EN". You may also be able to disable the auto-reset
by connecting a 110 ohm resistor from 5V to the reset line; see this forum thread for details.

USB Overcurrent Protection

The Arduino Uno has a resettable polyfuse that protects your computer's USB ports from shorts and
overcurrent. Although most computers provide their own internal protection, the fuse provides an extra layer
of protection. If more than 500 mA is applied to the USB port, the fuse will automatically break the connection
until the short or overload is removed.

Physical Characteristics

The maximum length and width of the Uno PCB are 2.7 and 2.1 inches respectively, with the USB connector
and power jack extending beyond the former dimension. Three screw holes allow the board to be attached to
a surface or case. Note that the distance between digital pins 7 and 8 is 160 mil (0.16"), not an even multiple
of the 100 mil spacing of the other pins.

@ El Radiospares RADIONICS ,4
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How to use Arduino

Arduino can sense the environment by receiving input from a variety of sensors and can affect its
surroundings by controlling lights, motors, and other actuators. The microcontroller on the board is
programmed using the Arduino programming language (based on Wiring) and the Arduino
development environment (based on Processing). Arduino projects can be stand-alone or they can
communicate with software on running on a computer (e.g. Flash, Processing, MaxMSP).

Arduino is a cross-platoform program. You'll have to follow different instructions for your personal
OS. Check on the Arduino site for the latest instructions. hitp:#/arduino.cc/en/Guide/HomePage

Linux Install Windows Install Mac Install

Once you have downloaded/unzipped the arduino IDE, you can Plug the Arduino to your PC via USB cable.

Blink led

MNow you’re actually ready to “burn” your e =T
first program on the arduino board. To

select “blink led”, the physical translation EEEEE
of the well known programming “hello

world”, select
File>Sketchbook> /1 The -
Arduino-0017>Examples> g mevw()
Digital>Blink pmaiesen, worme
1
Once you have your skecth }‘DU." 'IC o ZI T_':.t-hi-i|.l.t1". over md aver agetn,
see something very close to the
- wokd Loop
screenshot on the right. J e
digitalVeste (ledPin, HIGH): i
delay(l0d0) 2 Second
In Tools>Beard select T aaay R e e
) m

Now you have to go to
Tools>SerialPort

and select the right serial port, the
one arduino is attached to.

Done compiling.

Press Compile button ey : e
(to check for errors) Upload A RAX Flashing Blinking Led!

@ E‘ Radiospares RADIONICS ,4
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Dimensioned Drawing
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Terms & Condifions

1.  Warranties

1.1 The producer warrants that its products will conform io the Spedfications. This warranty lasts for one (1) years from the date of the sale. The
producer shall not be Bable for any defects that are caused by neglect, misuse or mistreatment by the Customer, including improper installation or testing,
or for any products that have been altered or modified in any way by a Customer. Moreover, The producer shall not be lisble for any defects that result from
Customer's design, spedfications or instructions for such products. Testing and other guality control technigues are used to the extent the producer deems
NECESEaTY.

1.2 Kany products fail to conform io the warranty set forth abowe, the producer's sole Bability shall be to replace such products. The producer’s liability
shall be limitad to products that are determined by the producer not to conform to such warranty. if the producer elects to replace such products, the
producer shall have & reasonable time to replacements. Replaced products shall be waranted for & new full warranty period.

1.3 EXCEPT AS SET FORTH ABOVE, PRODUCTS ARE PROVIDED "AS I5" AND "WITH ALL FAULTS * THE PRODUCER DISCLAIMS ALL OTHER
WARRANTIES, EXPRESS OR IMPLIED, REGARDING PRODUCTS, INCLUDING BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE

14  Customer agress that prior to using any systems that include the producer products, Customer willl test such systems and tha functionality of the
products &5 used in such systems. The producer may provide technical, applications or design advice, quality characterization, reliability data or other
senices. Customer acknowledges and agrees that providing these senvices shall not expand or otherwise alter the producer’s warranties, as set forth

above, and no additional obligations or liablities shall arise from the producer providing such services.

1.5  The Arduino™ products are not authorized for use in safety-critical applications where a failure of the product would reesonably be expected to cause
severe personal injury or death. Safety-Critical Applications indude, without limitation, life support devices and systems, equipment or systems for the
operation of nuclear facilities and weapons systems. Arduino™ products are neither designed nor intended for use in military or asrospace applications or
environments and for automotive applications or environment. Customer acknowledges and agrees that any such use of Arduino™ products which is solely
at the Customer's risk, and that Customer is solely responsible for compliance with all legal and regulatory requirements in connection with such use.

1.6 Customer acknowledges and agrees that it is solely responsible for compliance with all legal, regulatory and safety-related requirements concerning its
products and any use of Arduino™ products in Customer's applications, notwithstanding any applications-redsted information or support that may be
provided by the producer.

2. Indemnification

The Customer acknowledges and agrees to defend, indemnify and hold harmiess the producer from and against any and all third-party losses, damages,
liabdities and expenses it incurs to the extent direcfly caused by: (i) an actual breach by a Customer of the representation and warranties made under this
terms and conditions or () the gross negligence or willful misconduct by the Customer.

3 Consequential Damages Waiver

In no event the producer shall be liable to the Customer or any third parties for any special, collateral, indirect, punitive, incidental, consequential or
exemplary damages in connection with or arising out of the products provided hereunder, regardiess of whether the producer has been advised of the
possibility of such damages. This section will survive the termination of the warmanty period.

4. Changes to specifications

The producer may make changes to specifications and product descriptions at any time, without notice. The Customar must not rely on the absence or
characteristics of any features or instructions marked “reserved” or "undefined.” The producer reserves thess for future definition and shall have no
responsibiity whatsoever for conflicts or incompatibilities arising from future changes to them. The product information on the Web Site or Materials is
subject to change without nofice. Do not finalize & design with this information.

Enviromental Policies

The producer of Arduino™ has joined the Impatto Zero®
policy of LifeGate.it. For each Arduino board produced is
created / looked after half squared Km of Costa Rica's
forest's.

E E’ Radiospares RADIONICS %{%'m
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LAMPIRAN 11
DATASHEET RELAY MODULE 2-CHANNEL

Handson Technology

User Guide

2 Channel SV Optical Isolated Relav Module

This is a LOW Level 5V 2-channel relay interface board, and each channel needs a 15-20mA
driver current. It can be used to control various appliances and equipment with large current.
It is equipped with high-current relays that work under AC250V 10A or DC30V 10A. It has
a standard interface that can be controlled directly by microcontroller. This module is
optically isolated from high voltage side for safety requirement and also prevent ground loop
when interface to microcontroller.

Brief Data:

* Relay Maximum output: DC 30V/10A, AC 250V/10A.

e 2 Channcl Relay Module with Opto-coupler. LOW Level Trigger expansion board, which is
compatible with Arduino control board.

e Standard mterface that can be controlled directly by microcontroller ( 8051, AVR, *PIC, DSP,
ARM, ARM, MSP430, TTL logic).

* Reclay of high quality low noisc relays SPDT. A common terminal, 8 normally open, once
normally closed terminal.

o Opto-Coupler 1solation, for high voltage safety and prevent ground loop with microcontroller.

1 I www. handsontec.com
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Schematic:

WOC and RY-VOC are also the power supply of the relay module. When you need to drive a large power
load, you can take the jumper cap off and connect an extra power to RY-VCC to supply the relay; comnect
WCC to 5% of the MCU board to supply input signals.

NOTES: If you want complete optical isolation, connect "Vee™ to Arduino +5 volis but do NOT conmect

Arduino Ground. Remowve the Viee to JD-Vec jumper. Connect a separate +5 supply to "JD-Vec™ and board
CGind. This will supply power to the transistor drivers and relay coils.

If relay isolation is enough for your application, connect Arduing +5 and Gnd, and leave Vee to JD-Vee
Jumper in place.

RY-Wi M1
"r'{'{'c;F 1ML
LiMl 3
5
1
VO RN - 3 i
WOC 1
IM1 2
[ 3
GHD 3
IN2
INZ
s

It is sometimes possible to use this relay boards with 3.3V signals, if the JO-VCC (Relay Power) is provided
from a +5V supply and the VO to JD-VCC umper is removed That 5V relay supply could be totally
isolated from the 3.3V device, or have a common ground if opto-isolation is not needed. If used with
isplated 3.3V signals, VOO (To the input of the opto-solator, next to the IN pins) should be connected to the
3.3V device's +3.3V supply.

NOTE: Some Raspberry-Pi users have found that some relays are reliable and others do not actuate
sometimes. [t may be necessary to change the value of R1 from 1000 ohms to something like 220 ohms, or
supply +5% to the VOC connection.

2 www.handsontec.com
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NOTE: The digital inputs from Arduino are Active LOW: The relay actuates and LED lights when the input
pin is LOW, and turns off on HIGH.

Module Lavout:

S0rmm

/e iy
@ 2 Channels Relay )

T

TH

35mm
41mm—

[ —

@E®®®®

@

. Le (U]

A3mm

Operating Principle:

See the picture below: A is an electromagnet, B armature, C spring, D moving contact, and E fixed contacts.
There are two fixed contacts, a normally closed one and a normally open one. When the coil is not energized,
the normally open contact is the one that is off, while the normally closed one is the other that is on.

Supply voltage to the coil and some currents will pass through the coil thus generating the electromagnetic
effect. So the armature overcomes the tension of the spring and is attracted to the core, thus closing the
moving contact of the armature and the normally open (NO) contact or you may say releasing the former
and the normally closed (NC) contact. After the coil is de-energized, the electromagnetic force disappears
and the armature moves back to the original position, releasing the moving contact and normally closed
contact. The closing and releasing of the contacts results in power on and off of the circuit.

Input:
VCC : Connected to positive supply voltage (supply power according to relay voltage)
GND : Connected to supply ground.

IN1: Signal triggering terminal 1 of relay module
3 | www. handsontec.com
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IN2: Signal triggering terminal 2 of relay module

Ouiput:

Each module of the relay has one NC (normally close), one NO (normally open) and one COM (Common)
terminal. So there are 2 NC, 2 NO and 2 COM of the channel relay in total. NC stands for the normal close
port contact and the state without power. NO stands for the normal open port contact and the state with
power. COM means the common port. You can choose NC port or NO port according to whether power or
not.

Testing Setup:

When a low level is supplied to signal terminal of the 2-channel relay, the LED at the output terminal will
light up. Otherwise, it will turn off. If a periodic high and low level is supplied to the signal terminal, you
can see the LED will cyele between on and off.

4 www.handsontec.com
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LAMPIRAN 12

DATASHEET SENSOR PROXIMITY

PS-12 Inductive Proximity Switch

SAFEGUARDS AND PRECAUTIONS:

(E@E

Q Read and follow all instructions in this instruction sheet carefully, and retain this sheet for future reference.

Do not use this instrument in any manner inconsistent with these operating instructions or under any conditions that
d the i | specifii stated.

tachnleal anal P

This instrument is not user servi
purchased the product.

t the sales organization from which you

DESCRIPTION:

The PS-12 is a three wire sensor that outputs an open
collector PNP pulse. The sensor operates at a 0.15 inch (4
mm) gap with a 0.45 inch (12 mm) target and has a red LED
on-target indicator. The sensor is housed in a threaded
metal IP67 shell and supplied with an M12 nut and 6-foot
shielded cable with tinned wires.

e

s

SPECIFICATIONS:

Input Voltage:
Output:
Sensing Distance:

6-36 Vdc @ 15 mA
Open Collector PNP - Normally Open (NO)
0.15" (4 mm) - Target should be at least = sensor diameter

Sense Indicator: LED indicates target present

Max Speed: 24,000 RPM (400 Hz)
Operating Temp.: -13° to +167° F [-25° to +75° C]
Cable Length: 6 feet [1.8 m]
Material: Threaded metal
Protection: P67
Mechanical: Standard Size: M12
Dimensions: 2.0" (L) x 0.48" diameter [50 x 12 mm]
17 " 58 _
e 5 L
8 4 15 o
—IH 4 4P| LED indicator
y 4
i F ===
W M12x1
CONNECTION DETAIL:

BROWN

+Vdc
BLUE com
2225 OUT(NO)

BROWN +Vdc
BLACK L BROWN
PANEL
T0 RELAY
SENSOR OR tets
LOAD
= (200mA MAX)
BLUE COoMm

*NOTE: RL IS OFTEN INSIDE METER

DRIVING A LOAD DRIVING A METER
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OPERATING PRINCIPLE:

Inductive proximity switches are used for non-contact detection of metallic objects. Their operating principle is based on a coil and oscillator that
creates an electromagnetic field in the close surroundings of the sensing surface. The presence of a metallic object in the operating area causes
a dampening of the oscillation amplitude. The rise or fall of such oscillation is identified by a threshold circuit that changes the output of the
sensor. Current consumption of an inductive proximity switch decreases proportional to the metal object distance.

SETTING OPERATING DISTANCE:

To ensure stable operation at environmental extremes, the sensing distance should be set to

80% of the rated distance. The detection distance is dependent upon the size and material of

the target. The PS-12 is specified for an iron target. A stainless steel target will reduce the Target

sensing distance to 50%. Brass, Aluminum or Copper targets will reduce the sensing distance to lll Q

around 40%.
Proximity Switch
Active Face

This product may contain material which could be hazardous to human health and the environment. DO NOT DISPOSE of this
product as unsorted municipal waste. This product needs to be RECYCLED in accordance with local regulations, contact your local
NN  authorities for more information. This product may be returnable to your distributor for recycling - contact the distributor for details.

ﬁ In order to comply with EU Directive 2012/19/EU on Waste Electrical and Electronic Equipment (WEEE):

CE Compliant. RoHS Compliant.

Monarch Instrument'’s Limited Warranty applies. See www.monarchinstrument.com for details.

Warranty Registration and Extended Warranty coverage available online at www.monarchinstrument.com.
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